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DSP ĠLE GERÇEK ZAMANLI SAYISAL VĠDEO STABĠLĠZASYONU 

 

ÖZET 

 

Video stabilizasyon sistemlerinin amacı kameralardan elde edilen video 

görüntülerinde titreşim veya el titremesinden kaynaklanan istenmeyen hareketleri 

ayrıştırarak, istenen hareketleri koruyan yeni bir video dizisinin elde edilmesidir. 

 

Video stabilizasyon sistemi çerçeveler arası bütünsel hareket vektörlerini belirleyen 

hareket kestirim sistemi, hareket kestirim sistemi sonucu elde edilen konum 

vektörlerinden istenmeyen hareketleri ayrıştıran istenen hareketleri koruyarak 

düzeltilmiş yeni bir video dizininin oluşmasını sağlayan hareket düzeltim sistemi 

olmak üzere iki kısımdan oluşmaktadır. 

 

Bu tez çalışmasında gerçekleştirilen video stabilizasyon sistemi, faz korelasyonu 

temelli hareket kestirimi ve Kalman süzgeci temelli  hareket düzeltimi sisteminden 

oluşmaktadır. Geliştirilen sistem, Texas Instruments TMS320DM6437 DSP 

geliştirme platformunda gerçek zamanlı olarak  başarılı bir şekilde uygulanmıştır. 

 

Anahtar Kelimeler: DSP, Faz Korelasyonu, Kalman Filtresi, Video Stabilizasyonu. 
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REAL TIME DIGITAL VIDEO STABILIZATION WITH DSP 

 

ABSTRACT  

 

The purpose of the stabilization systems is getting new video sequences by reducing 

unwanted irregular motions caused by unstable handshaking or vibration and keeping 

wanted changes in video sequence captured by cameras. 

 

Video stabilization system consists of motion estimation system which determines 

interframe global motion vectors and motion correction system which computes a 

new corrected video sequences by keeping intentional movements and reducing 

unwanted movements obtained from motion estimation system. 

 

The video stabilization system developed in this thesis study consists of phase 

correlation based global motion estimation and Kalman filtering based motion 

correction. The developed system is implemented on a Texas Instruments 

TMS320DM6437 evaluation platform successfully in real-time. 

 

Key Words: DSP, Phase Correlation, Kalman Filter, Video Stabilization.
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GĠRĠġ 

Gelişen ve bununla beraber boyutları küçülen kamera teknolojisiyle birlikte, 

hareketli düzeneğe bağlı veya elle çekim yapan kameralarda yürürken veya hareket 

halindeyken kamerayı sabit tutmak zordur ve bu durum video görüntülerinde 

istenmeyen  bozulmalara yol açmaktadır. Video stabilizasyon sistemlerinin amacı 

istenmeyen düzensiz el titremesi yüzünden oluşan hareketlerin veya titreşim kaynaklı 

istenmeyen değişimlerin(yakınlaştırma, kayma, rotasyon) bastırılarak sadece istenen 

hareketlerin olduğu yeni bir video dizisinin oluşturulmasıdır. 

Video stabilizasyonu geniş bir kullanım alanına sahiptir ve gelişen teknolojiyle 

beraber kullanım alanları artmaktadır. Video stabilizasyonunun; 

i) Amatör kameraman tarafından yapılan çekimlerde kameranın sabit 

tutulamamasından kaynaklanan titreşim, yakınlaştırma, rotasyon gibi etkilerin 

bastırılması, 

ii)  Engebeli arazide hareket eden araçlardan veya havadan yapılan çekimlerde 

oluşan titreşim, yakınlaştırma ve rotasyon gibi etkilerin bastırılması, 

iii) Kontrolü uzaktan gerçekleştirilen kamera monte edilmiş robotların mekanik 

aksamından kaynaklanan titreşim hareketlerinin bastırılmasında, 

iv) Mobil cihazlarda görüntülü görüşme sırasında mobil cihazın hareketinden 

oluşabilecek titreşimlerin bastırılması gibi kullanım alanları mevcuttur. 

Sayısal video stabilizasyon sistemlerinin yukarıda bahsedildiği pek çok alanda 

gerçek zamanlı olarak çalıştırılması gerekmektedir. Özellikle donanımsal 

gerçekleştirmenin gerektiği uygulamalarda stabilizasyon uygulamalarının gerçek 

zamanlı olarak gerekli donanımda çalıştırılması büyük sorun teşkil etmektedir. 
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Kamera görüntülerinde bütünsel hareket ve yerel hareket olmak üzere iki tür 

hareketten söz edilebilir. Video stabilizasyonu için bütünsel hareket önemli 

olmaktadır. Bir videonun bütünsel hareketi ele alınarak  görüntüdeki değişim, 

kameranın kasıtlı olarak hareketinden kaynaklanan  istenen değişim ve titreşimlerden 

kaynaklanan istenmeyen değişim olarak ikiye ayrılır. Dolayısıyla sayısal video 

stabilizasyon sistemlerinin  amacı bir video dizinindeki istenmeyen düzensiz 

bütünsel hareketlerin tespit edilip bu hareketlerin önlenerek sadece istenen 

değişimlerin gözlendiği daha düzgün  bir video dizisinin elde edilmesidir. Bir sayısal 

video stabilizasyon sistemi hareket kestirim sistemi ve hareket düzeltim sistemi 

olarak ikiye ayrılır. Hareket kestirim sistemi, hareket düzeltim sistemine girdi olacak, 

çerçeveler arası bütünsel hareket vektörlerini kestirmektedir. Hareket düzeltim 

sistemi ise hareket kestirim sisteminden gelen hareket vektörlerinden istenmeyen 

hareketlerin bastırıldığı yeni hareket vektörlerini elde etmektedir [1].  

Bu tez çalışması kapsamında faz korelasyonu temelli bir bütünsel hareket kestirim 

yöntemi ile Kalman fitresi temelli bir hareket düzeltim yöntemi kullanan bir video 

stabilizasyon sistemi gerçek zamanlı olarak bir DSP üzerinde çalıştırılmıştır. 

Tez çalışmasının ikinci bölümünde ilk olarak video stabilizasyonun iki aşamasından 

biri olan hareket kestim sistemi üzerinde durulmuştur. Hareket kestirimi hakkında 

temel bilgiler verilmiştir. Hareket kestirim teknikleri genel olarak incelenmiş, 

çalışma kapsamında video stabilizasyon sisteminin hareket kestirim yöntemi olarak 

kullanılan faz korelasyonu ayrıntılı incelenmiştir. 

Çalışmanın üçüncü kısmında, video stabilizasyonunun ikinci aşaması olan hareket 

düzeltim sistemi anlatılmıştır. Hareket düzeltim sistemi için kullanılan çeşitli 

yöntemler karşılaştırılmıştır. Bu tez çalışmasında video stabilizasyonu sisteminin 

hareket düzeltim yöntemi olarak tercih edilen Kalman Filtresi ayrıntılı olarak ele 

alınmıştır. 

Çalışmanın dördüncü kısmında, Sayısal İşaret İşleyiciler (DSP) hakkında detaylı 

bilgiler verilmiştir. Tez çalışmasında video stabilizasyon sisteminin üzerinde 

gerçeklendiği TMS320DM6437 kiti ayrıntılı incelenmiştir.  
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Çalışmanın son bölümünde ise, tez kapsamında geliştirilen video stabilizasyon 

sisteminin detayları deneysel sonuçlar ile birlikte verilmiştir. Video stabilizasyon 

sisteminin geliştirilmesi sırasında kitin kullanımı hakkında bilgiler verilmiştir. 

Önerilen video stabilizasyon sisteminin DSP üzerinde uygulanmasında karşılaşılan 

zorluklar ve buna karşın bulunan çözümler detaylı bir şekilde gösterilmiştir. 
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1.  HAREKET KESTĠRĠM SĠSTEMĠ 

Video stabilizasyonunda hareket kestirimi, bir video dizininde çerçeveler arası 

bütünsel hareket vektörlerini belirlemek amaçlı kullanılmaktadır. Hareket kestirim 

sisteminin çalışması, hareket düzeltim sisteminin başarımını doğrudan 

etkilemektedir. Dolayısıyla hareket vektörlerinin doğru bir şekilde tespit edilmesi 

önem arz etmektedir.  

1.1.  GiriĢ 

Bilindiği gibi video görüntüleri çerçevelerden oluşmaktadır. Ardışık çerçeveler arası 

ise global olarak bir değişim söz konusudur. Bu yer değişim hareket vektörü ile ifade 

edilebilir. Bütünsel hareket kestiriminde hareket vektörü başka bir ifadeyle t anındaki 

çerçevenin (t + 1) anında genel olarak ne kadar yer değiştirdiğidir. Hareket kestirimi 

yerel olarak MPEG-1, MPEG-2, MPEG-4, H.261, H.263, H.264/AVC-2 gibi video 

kodlama sistemlerinde yaygın olarak kullanılmaktadır. Şekil 1.1‟de bir hareket 

vektörü gösterilmiştir. t anındaki p noktası t + ∆t anında p‟ noktasına taşınmıştır. 

Dolayısıyla p‟ noktası ile p noktası arasında yer değiştirme hareket vektörü d ile 

ifade edilebilir. Bu hareket vektörünün x-yönündeki bileşeni dx vektörü olurken, y-

yönündeki bileşeni ise dy vektörü olmaktadır. 

 

Şekil 1.1. Hareket vektörünün gösterilmesi [2] 



 

5 

 

Hareket kestirim sisteminde blok hareket  modeli, blok eşleme,  öznitelik eşleme ve 

faz korelasyonu gibi yöntemler kullanılmaktadır. Hareket gösterimi için Şekil 1.2‟de 

gösterilen bütünsel bazlı, piksel bazlı, blok bazlı ve bölge bazlı olmak üzere 4 çeşit 

gösterim şekli bulunmaktadır. 

 

Şekil 1.2. Hareket gösterim şekilleri [20] a)  Genel bazlı b) 

Piksel bazlı  c) Blok bazlı d) Bölge bazlı 

Video stabilizasyonunda çerçevelerin genel hareketi önemli olduğundan bu tez 

çalışmasında bütünsel hareket kestirimi kullanılmıştır. Bütünsel hareket kestiriminde 

çerçevenin hepsi kullanılabileceği gibi çerçeveden alınan belirli büyüklükteki bir 

blok da kullanılabilir. Kullanılacak bloğun büyüklüğü hareket kestiriminin 

başarımında önemli rol oynamaktadır.  

1.2.  Hareket Kestirim Teknikleri 

Hareket kestirim teknikleri genel olarak ikiye ayrılabilmektedir: 

 Zaman Uzayında Çalışan Algoritmalar(Time-Domain Algorithms) 

 Frekans Uzayında Çalışan Algoritmalar(Frequency-Domain Algorithms) 
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Zaman uzayında çalışan algoritmalar ise üçe ayrılmaktadır: 

 Blok Eşleme (Block Matching) 

 Özellik Eşleme(Feature Matching) 

 Ön görümlü Hareket Kestirimi(Predictive of Motion Vectors) 

Blok eşleme kriterinde ilgili çerçevenin bloğuyla bir önceki çerçevenin blokları 

arama penceresinde karşılaştırılmaktadır.  

Özellik eşleme blok eşleştirmeden farklı olmakla birlikte çerçeveden çekilen bir 

resim elemanı arama penceresinde karşılaştırılmaktadır. Morfolojik filtreler 

yardımıyla eşleştirme yapılabilir. 

Ön görümlü hareket kestirimiyse bir sonraki hareket vektörünün öncelikli kestirimine 

dayanmaktadır. 

Frekans uzayında çalışan algoritmalar frekans uzayına dönüştürülmüş çerçeveler 

arasındaki dönüşüm katsayıları arasındaki ilişkiye dayanır. Bu tür hareket kestirim 

yaklaşımları görüntü dizisi kodlamada genellikle kullanılmaz. Bu tekniklerde bloklar 

ilk olarak frekans uzayına dönüştürülmelidir. Bazı frekans bazlı algoritmalar aşağıda 

sıralanmıştır: 

 Faz Korelasyonu(Phase Correlation) 

 DCT Uzayında eşleme(Matching in DCT domain) 

 Dalgacık Uzayında Eşleme(Matching in Wavelet Domain) 

Literatürde hareket kestirimi üzerine birçok çalışma bulunmaktadır.  Öteleme 

şeklindeki çerçeveler arası hareketin tespitinde bütün çerçeveyi, öteleme hareket 

vektörlerini tespit etmek için kullanan en etkili yöntem MAD (Mean Absolute 

Difference) ve MSE (Mean Square Error) uyulmama kriterlerini kullanan, tam arama 

(Full Search) çerçeve eşleştirme yöntemidir. Ancak tam arama yönteminin hesapsal 

yükü fazladır ve bu durum gerçek-zamanlı uygulamalar için sorun olmaktadır [1]. 

Harris özellik noktalarını kullanarak yapılan bir yöntemden [3]‟te bahsedilmektedir. 

Bu yaklaşımda, çerçeveler arası global hareket vektörleri Harris özellikleri ve Lucas-

Kanade yöntemi kullanılarak bulunmaktadır. İstenmeyen hareketler ise bir 
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sönümlendirici süzgeç kullanılarak ayrılmıştır. Bu yaklaşımın, stabilizasyon 

performansı kabul edilebilir olmasına karşın donanıma uygulanması  zor ve hesapsal  

yükü fazladır. [4]‟te bahsedilen Kenar örüntü eşleştirmesi (Edge Pattern Matching) 

yönteminde, stabilizasyon başarımında kayıplara neden olmasına karşın,  donanıma 

uygulanması için uygun karmaşıklığa sahiptir. Video stabilizasyonu için bit-düzlemi 

uyumlama tabanlı hızlı hareket kestirimi yöntemleri [5,-8]‟de sunulmaktadır. Bu 

yaklaşımlarda ise, hesapsal karmaşıklık hareket kestiriminde donanımsal olarak 

verimli olarak gerçeklenebilen mantıksal (logical) işlevler kullanılarak azaltılmıştır.  

Faz korelasyonu, hızlı Fourier dönüşümü (Fast Fourier Transform-FFT) tabanlı bir 

çerçeve uyumlama yaklaşımı olarak kullanılabilir [7]. Yerel hareketlerden göreceli 

olarak az etkilenen yöntem olmasına karşın, tüm giriş çerçevesi üzerinden işlem 

yapması hesapsal yükü arttırmaktadır. Bu tez çalışması kapsamında hareket kestirim 

yöntemlerinden faz korelasyonu yöntemi kullanılmıştır.  

1.3.  Faz Korelasyonu 

Faz korelasyonu ayrık Fourier dönüşümünün temel özelliklerinden faydalanan ve eşit 

boyutlu iki işaretin veya imgenin benzerliğini belirlemekte kullanılan bir korelasyon 

yöntemidir. Bu doğrultuda  kI x,y  ve  Ik+1 x,y , iki ardışık çerçeveyi ve Fk u,v  ve  

Fk+1 u,v  bu çerçevelerin ayrık Fourier dönüşümü olacak olursa faz korelasyonu 

yüzeyi Eşitlik (1.1)‟deki gibi gösterilebilir. 

   

   

*

k k+1-1

(k, k+1)

k+1

*

k

F u,v ×F u,v
S =F

F u,v ×F u,v

 
 
  

                                                                           (1.1) 

Bu eşitlikte F-1 , ters ayrık Fourier dönüşümü göstermektedir. Faz korelasyonu, 

Fourier dönüşümünün özelliklerini kullanarak gürültü azaltma ve video sıkıştırma 

gibi değişik uygulamaların yanı sıra imge çerçeveleri arasındaki benzerlikleri 

algılama amaçlı da kullanılmaktadır. Faz korelasyonu yüzeyi iki imge çerçevesi 

arasında benzerliğin fazla olması durumunda yüksek bir tepe değeri vermektedir.  
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Ik+1 imgesini, Ik imgesinin yatay ve dikeyde dx ve dy  kadar yer değiştirmiş  hali 

olarak ele alırsak k+1I  ve k+1F ; 

   k+1 k x y= α×IF x, x-d , y y-d                     (1.2) 

x y-j(ud +vd )

k+1 kF (u,v)=α×F (u,v)e                                                                         (1.3) 

Eşitlik (1.2) ve Eşitlik (1.3)‟deki gibi olacaktır. Bu durumda faz korelasyonu yüzeyi 

ise Eşitlik (1.4)‟deki gibi oluşmaktadır; 

   

   

*

k k+1-1

(k, k+1)

k+1

*

k

F u,v ×F u,v
S =F

F u,v ×F u,v

 
 
  

  

         x y-j(ud + vd )-1=F e 
 

 

         x y=δ(x+d , y+d )                    (1.4) 

Eşitlik (1.4)‟den de anlaşılacağı gibi bu durum iki imge arasında bütünsel öteleme 

hareketi (global translational shift) olması durumunda dahi geçerlidir [21]. Çünkü 

bütünsel ötelemenin etkisi sadece faz korelasyon yüzeyinde tepe değerin yer 

değiştirmesi olarak ortaya çıkmaktadır. İmge çerçeveleri arasındaki benzerlik az ise 

veya bütünsel hareket sadece basit öteleme hareketi ile çözülemiyorsa korelasyon 

yüzeyi tepe değeri düşük olacaktır [20]. Benzerlik; faz korelasyonu sonucu oluşan 

faz korelasyonu yüzeyinin maksimum değerii ile belirlenir. Bu maksimum değer 

yorumlanarak çerçeveler arası benzerlik belirlenebilir. Çerçeveler arası bütünsel 

hareket faz korelasyonu yüzeyinin maksimum değerinin yeri yorumlanarak 

bulunabilmektedir. İki çerçeve arası hareket olmaması durumunda tepe değerin yeri 

değişmezken, hareket olması durumunda hareket değerine bağlı olarak tepe değerin 

yeri değişmektedir. Şekil 1.3‟te “Bike” video dizisinden örnek iki ardışıl çerçeve 

gösterilirken, Şekil 1.4‟te bu iki çerçevenin faz korelasyonu yüzeyi gösterilmektedir. 
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Şekil 1.3. Bike video dizisinden örnek iki ardışıl çerçeve 

 

Şekil 1.4. Şekil 1.3‟deki çerçevelerin faz korelasyonu yüzeyi 
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2.  HAREKET DÜZELTĠM SĠSTEMĠ 

2.1.  GiriĢ 

Hareket düzeltim sisteminin amacı, video dizisinden hareket kestirimi ile elde edilen 

konum vektörlerinden  titreşimlerin arındırılması ile istenen hareketlerin korunduğu 

yeni konum vektörlerinin elde edilmesidir. Hareket düzeltim sistemlerinde 

stabilizasyon için çeşitli yöntemler kullanılmaktadır.  

2.2.  Hareket Düzeltim Teknikleri 

Hareket düzeltim sistemlerinde kullanılan yöntemlerden biri olan hareket vektör 

tümleştirme yöntemi (Motion Vector Integration) [9]'da önerilmiştir. Önerilen 

yöntem görüntü içerisindeki hareketli nesneler gibi düzensiz değişimlere karşın 

gürbüzdür (robust). [10]‟da ayrık Fourier dönüşümü (Discreet  Fourier Transform -

DFT) tabanlı çerçeve konum yumuşatma yöntemi sunulmaktadır. Bu yöntem gerçek 

zamanlı uygulamalar için uygun olmasına karşın,  düzeltilmiş hareket eğrisi gerçek 

kamera değişimlerine göre gecikmelidir. Kalman filtresi  tabanlı hareket düzeltimi 

ise [11,12]‟de önerilmektedir. Bu çalışmada, düşük hesapsal yük ve düzeltim 

sağlayan Kalman filtresi kullanılmıştır. Kalman filtresi gerçek-zamanlı 

uygulamalarda büyük avantaj sağlamaktadır. 

2.3.  Kalman Filtresi ile Video Stabilizasyonu 

Matematiksel özellikleri bakımından gerçek zamanlı uygulamalar için uygun olan 

Kalman filtresi, sistem ve ölçüm gürültüsü Gauss ile temsil edilen doğrusal 

gözlemleme modeliyle tanımlanmış bir sistem için durum tahminini 

gerçekleştirmektedir. Kalman filtresi, bir önceki çerçevedeki yörüngeye dayanan bir 

hareket tahmini yapabilmektedir. Kalman filtresinin doğrusal dinamik sistem formu 

Eşitlik (2.1)‟de tanımlanmıştır: 
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x(t+1)=Fx(t)+w(t)                    (2.1) 

Bu eşitlikte görüldüğü üzere bu sistem F matrisine ve önceki duruma bağlıdır. w(t) 

ise işlem gürültüsü olarak adlandırılmaktadır. Kalman filtresi durum 

değişkenlerinin tümüne veya bir kısmına bağlı olarak gözlemler yürütecektir. 

Gözlemler sistemi ise Eşitlik (2.2)‟deki gibi tanımlanmıştır: 

y(t+1)=Hy(t)+v(t)                  (2.2) 

Gözlem değişkenleri doğrusal olarak H matrisinden doğru durum değişkenleriyle 

ilişkilidir. v(t) ise ölçüm gürültüsü olarak adlandırılmaktadır. Tanımlanması 

itibariyle Kalman filtresi, işlem ve ölçüm gürültüleri birbirinden bağımsız ve 

normal olasılık dağılımlarına bağlı olarak N~(0,Q) ve N~(0,R) şeklinde 

tanımlanmıştır. Şekil 2.1‟de Kalman filtresinin ölçüm ve işlem gürültüsü değerlerine 

bağlı olarak geri besleme döngüsü gösterilmektedir. 

 

Şekil 2.1. Kalman filtresi geri besleme döngüsü 

Stabilizasyon işlemi için bulunan konum vektörleri kalman filtresinden 

geçirilecektir. Yatay ve düşey düzlemde konum vektörleri (x1, x2) olmak üzere anlık 

hız değerleride (dx1, dx2) olduğu düşünülürse, doğrusal dinamik sistem Eşitlik 

(2.3)‟deki gibi tanımlanmaktadır: 
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1 1 1

2 2 2

1 1 1

2 2 2

x (n) x (n-1) wx1 0 1 0

x (n) x (n-1) wx0 1 0 1
= +

dx (n) 0 0 1 0 dx (n-1) wdx

0 0 0 1dx (n) dx (n-1) wdx

      
      
      
      
      

      

                    (2.3) 

Hareket tahmin sistemindeki hareket vektörleri kullanılarak gerçek zamanlı konum 

vektörlerinin kullanıldığı gözleme sistemi Eşitlik (2.4)‟deki gibi tanımlanmıştır: 

1

1 2 1

2 1 2

2

x (n)

y (n) x (n) vx1 0 0 0
= +

y (n) 0 1 0 0 dx (n) vx

dx (n)

 
 

      
          

 
 

                            (2.4) 

Kalman filtresi tahmin ve düzeltme kısmı olarak ikiye ayırabiliriz. İlk olarak tahmin 

sisteminin bir sonraki çerçeveye göre tahmini Eşitlik (2.5)‟deki gibi 

gerçekleştirilmektedir: 

n+1 nx =Fx                       (2.5) 

Eşitlik (2.5)‟de
n+1x , bir sonraki çerçevenin konum tahminini göstermektedir. x n, ise 

bir önceki konumun düzeltilmiş halini göstermektedir. Bir sonraki konumun 

kestirimi esnasında olması gereken hata koveryansı Eşitlik (2.6)‟da belirtilmiştir: 

- T

n+1 nP =FP F + Q                              (2.6) 

Düzeltme aşamasındaysa kazanç matrisi kullanılarak düzeltilmiş konum vektörü 

Eşitlik (2.7) ve Eşitlik (2.8)‟deki gibi bulunacaktır: 

 
-1

- T - T

n n nK =P H HP H + R                     (2.7) 

x n=x n
-
 + Kn(y

n
- Hx n

-
)                                                                                       (2.8) 

Düzeltilmiş kısmında belirli bir düzeltilmiş hata koveryansı değeri Eşitlik (2.9)‟daki 

gibi oluşacaktır: 
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Pn=(I- KnH) Pn
-                                                  (2.9) 

Konum vektörü Xorj(n), bu çerçeve için Kalman Filtresinin bulduğu düzgünleştirilmiş 

konum vektörü XKlm(n) ile gösterilirse, çerçevenin düzeltme vektörü kalman 

filtrelemesi sonucu elde edilen düzeltilmiş konum vektörlerinden kameradan çekim 

esnasında kaydedilmiş orijinal konum vektörlerinin çıkartılması sonucu Eşitlik 

(2.10)‟daki gibi elde edilmektedir [15]: 

Vdüz(n) = XKlm(n) – Xorj(n)                 (2.10) 

2.4.  Kalman Filtresi Varyans Degerlerinin Tanıtılması 

Kalman filtresi yapısı itibariyle aldığı giriş ölçümlerine göre davranışını 

ayarlayabilmektedir. Bunu filtre yapısında bulunan işlem gürültüsü ve ölçüm 

gürültüsü ile gerçekleştirmektedir.  İşlem gürültüsü ve ölçüm gürültüsü, Kalman 

filtresinin parametreleridir,  ve bu parametreler Kalman filtresinin çalışma biçimini 

doğrudan etkilediklerinden, bunlar için kullanılan değişinti (variance) değerleri 

önemlidir. Video stabilizasyonu için Q değerinin 0 ile 1 arasında seçilmesi uygun 

olmaktadır. 

Stabilizasyon işlemi için kamera hareketinin yön ve hızında meydana gelebilecek 

değişimler işlem gürültüsü varyansı Q sayesinde yakalanabilmektedir. Kalman 

filtresinin işlem gürültüsü varyansı küçük alındığında harekette meydana gelen 

değişimleri iyi takip edemezken, buna karşın stabilizasyon başarımı yüksektir. Bu 

değerin büyük alınması ise değişikliklerin yakından  takip edilmesine neden 

olarak,stabilizasyon performansını düşürmektedir.  

Ölçüm gürültüsü varyansı R ise, Kalman filtresinin ölçüm değerleri için kabul 

edilebilecek titreşim bileşeninin değişme miktarını belirler. Bu değer küçük 

alındığında sistem, ölçüm değerlerini iyi kabul ederek hareketteki en küçük değerli 

titremeleri de takip etmektedir. Bu durum stabilizasyon yoğunluğunu düşürmektedir. 

Varyans değeri büyük alındığında ise sistem ölçüm değerlerini kötü kabul 

etmektedir. Bu durumda stabilizasyon şiddeti yüksek olmasına karşın sistem ölçüm 

değerlerine gecikmeli olarak tepki vermektedir [15]. 
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3.  DSP ĠLE SAYISAL VĠDEO ĠġLEME 

3.1.  GiriĢ 

Sayısal işaret işleyiciler çok yüksek hesap yükü getiren algoritmaları hızlı şekilde 

yerine getirmek için kullanılmaktadır. Sensörden alınan işaretler analogdan sayısala 

dönüştürülüp işlendikten sonra Şekil 3.1‟de gösterildiği gibi gerekirse tekrar analog 

işarete dönüştürülmektedir. 

 

Şekil 3.1. Tipik bir işaret işleme sisteminin blok gösterimi 

Bazı genel amaçlı işlemciler ve işletim sistemleri işaret işleme algoritmaları yerine 

getirebilir fakat daha fazla güç tüketimi ve çip üzerindeki yer problemleri yüzünden 

cep telefonu gibi taşınabilir cihazlarda bu işlemciler uygun olmadığından işaret 

işleyiciler kullanılması gerekmektedir. Ayrıca DSP ile tasarım yapmanın 

mikroişlemcilere göre yüksek hızlı işaret işleme, güvenilirlik,  yüksek performans, 

ucuz sistem maliyeti gibi avantajları da mevcuttur. 

Mikroişlemcilerin yüksek hesap yüküne cevap verememesi nedeniyle Analog 

Device, Motorola ve Texas Instruments gibi büyük firmalar 1980 yılından itibaren 

özel sayısal işaret işleme işlemlerini yerine getirecek sayısal işaret işleyicileri 

geliştirmektedir. 



 

15 

 

3.2.  DSP Mimarisi 

Sayısal İşaret İşleyiciler kendilerine özgü kodlarla  programlanmaktadır. Program 

yüklü DSP‟lerin her saat çevriminde hangi matematiksel işlemi yerine getireceği 

tanımlıdır. DSP bellekten gelen verileri ve komutları alır, bu verileri ilgili komutlara 

göre işler ve tekrardan belleğe geri gönderir. Bu işlemler için iki farklı donanım 

mimarisi kullanılmaktadır. 

3.2.1.  Von Neumann Mimarisi 

Bilgisayarlarda ilk kullanılan ve adını mimariye yön veren ünlü matematikçi John 

von Neuman'dan alan bir tasarım yaklaşımıdır. Bazen Princeton mimarisi de denilen 

bu mimari yapıya sahip ilk bilgisayarlarda, transistör yerine lamba (vakum tüp) 

kullanılmaktaydı.Von Neumann mimarisi günümüzde bir çok mikroişlemcili 

sistemde kullanılmaktadır. Von Neuman mimarisinde, veri ve komutlar bellekten tek 

bir yoldan mikroişlemciye getirilerek işlenmektedir. Program ve veri aynı bellekte 

bulunduğundan, komut ve veri gerekli olduğunda aynı iletişim yolu kullanılmaktadır. 

Bu durumda, komut için bir saat çevrimi, sonra veri için diğer bir saat çevrimi 

gerekmektedir [16]. Şekil 3.2‟de örnek bir Von Neumann mimarisi gösterilmektedir. 

 

Şekil 3.2. Von Neumann mimarisi [16] 
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3.2.2.  Harvard Mimarisi 

Harvard mimarili bilgisayar sistemlerinde, Von Neumann mimarisinden farklı olarak 

veri ve komutlar ayrı belleklerde tutulmakladır. Buna göre, veri ve komut 

aktarımında iletişim yolları da bir birinden bağımsız yapıdadır. Komutla birlikte veri 

aynı saat çevriminde farklı iletişim yolundan ilgili belleklerden alınıp işlemciye 

getirilebilir. Getirilen komut işlenip ilgili verisi veri belleğinden alınırken sıradaki 

komut, komut belleğinden alınıp getirilebilir. Bu önden alıp getirme işlemi, dallanma 

haricinde hızı iki katına çıkarabilmekledir [16]. Şekil 3.3‟te örnek bir Harvard 

mimarisi gösterilmektedir. 

 

Şekil 3.3. Harvard mimarisi [16] 

Bu tez çalışmasında kullanılan TMS320DM6437 geliştirme kartının işlemcisi olan 

TMS320C64x işlemcisi Harvard Mimarisini kullanmaktadır. 

3.3.  TMS320DM6437 Sayısal ĠĢaret ĠĢleyicisi 

Bu çalışmada üzerinde uygulamalar geliştirilen TMS320DM6437 kullanıcılara PCI 

tabanlı veya bağımsız olarak video ve ses uygulamaları geliştirebilmesine olanak 

sağlayan geliştirme platformudur. DM6437 platformunda bir TVP5146M2 video 

çözücü yardımıyla video dizileri işlemciye yönlendirilmektedir.  Çıkışta videoları 
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gösterme fonksiyonları ise yazılımsal olarak DM6437 işlemcisi tarafından 

yürütülmektedir. 4 adet DAC çıkışı tarafından ise görüntüler TFT monitöre 

gönderilmektedir [17]. Video sistemi VPSS(Video Processing Sub System) 

bölümünde detaylı olarak anlatılacaktır. 

Geliştirme kitinin sahip olduğu donanımsal özellikler aşağıda sıralanmıştır: 

 400, 500, 600, 700 MHz hızlarında çalışabilen işlemci 

 TVP5146M2 Video çözücü 

 4 Video DAC çıkışı 

 128 Mbyte DDR2 DRAM 

 UART, CAN I/0 arayüzleri 

 16 Mbyte Flash hafıza, 64 Mbyte NAND flash hafıza, 2Mbyte SRAM 

 AIC33 stereo kodek 

 I
2
C arayüzü 

 10/100 MBS Ethernet arayüzü 

 Gömülü JTAG arayüzü 

 Tek voltaj güç kaynagı(+5V) 

 Daughter Kart kullanımı 

 VLYNQ arayüzü 

 S/PDIF arayüzü, analog ve optic 

 32 bit DDR2 SDRAM 

 İki adet 64 bit genel amaçlı zamanlayıcı 

 64 Mbyte
 
adresleme erişimine sahip genişletilmiş bellek erişimi 

denetleyicisi(EDMA) 

 İki adet çok kanallı seri port (McBSP) 

 Video işleme alt sistemi(VPSS) 

TMS320DM6437 sayısal işaret işleme geliştirme kitinin blok diyagramı Şekil 3.4‟te 

gösterilmektedir. 
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Şekil 3.4. TMS320DM6437 blok diyagramı [17] 

3.3.1. Video ĠĢleme Alt Sistemi 

Video İşleme Alt Sistemi video çözücüleri veya görüntü algılayıcılarından görüntü 

alımı için bir giriş sistemi(VPFE) ve SDTV görüntüleyicileri, dijital LCD‟ ler gibi 

çıkış sistemleri için ise bir çıkış sistemi(VPBE) desteklemektedir. Bu çevresel 

birimlerle birlikte DD2 hafıza denetleyicisini etkin bir şekilde kullanabilmek için 

tampon hafızası ve doğrudan hafıza erişimi(DMA) denetleyicileri mevcuttur. 

Paylaşılmış tampon hafıza VPFE ve VPBE modülleri arasındaki haberleşmeyi 

sağlamasının yanı sıra DDR2 hafıza denetleyicisiyle arasında veri iletimini 

sağlamaktadır. Video İşleme Alt Sistemi blok diyagramı Şekil 3.5‟te gösterilmiştir. 

 

Şekil 3.5. VPSS blok diyagramı [18] 
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3.3.1.1. Video iĢleme ön kısmı(VPFE) 

VPFE CCD Denetleyicisi(CCDC), önizleyici makine görüntü hattı(IPIPE), donanım 

3A istatiksel yaratıcı(H3A), tekrar boyutlandırıcı ve histogram bloklarından 

oluşmaktadır. Bu modüller güçlü ve esnek bir ön arayüz sağlamaktadır. Bu modüller 

iki kısma ayrılabilir. 

Birinci kısım veri akış yolunda bulunan ve giriş görüntü dizi verilerini 

etkilemektedir. Bu kısımda bulunan CCD denetleyicisi görüntü algılayıcıları ve 

sayısal görüntü kaynaklarına arayüz sağlamaktadır. Önizleyici makine IPIPE video 

kaydetme modları, video çerçeve oranları ve iyi görüntü kalitesi elde etmek için 

kendine ait görüntü işleme bloklarını parametrelendirmektedir. Boyutlandırıcı ise 

giriş görüntü veri dizisini video kodlama çözünürlüğüne ve istenen çıkışa 

boyutlandırmayı sağlar. 

İkinci kısımdaysa kamera sistem tasarımcılarına yardım etmek için gelen görüntü 

verilerinin iyileştirilmesini sağlamaktadır. H3A modülü CCD kameradan alınan ham 

görüntü verilerinde otomatik odaklandırma (Auto Focus-AF), otomatik beyaz denge 

(Auto White Balance-AWB), otomatik ışıklandırma (Auto Enlightenment-AE) için 

kontrol döngüleri sağlamak için tasarlanmıştır. Histogram modülü giriş renk 

piksellerini genliğe bağlı olarak ayarlamaktadır. Ayrıca son görüntü, video çıkışı 

kanal ayarlarını sağlamaktadır. Histogram modülü CCD denetleyicisinden yada 

DD2„ den ham alınan görüntülerde işlem yapabilmektedir. 

3.3.1.2. Video iĢleme arka kısmı(VPBE) 

VPBE bloğu ekran göstericisi (OSD) ve video kodlayıcı (VENC) modüllerinden 

oluşmaktadır.  

Ekranda gösterici (OSD) grafik hızlandırıcı donanımsal gösterim pencerelerinde 

verilerin gösterilmesini sağlar. Aynı zamanda pencerelerin karıştırılarak tek bir 

çerçevede gösterilmesini yetkilendirmektedir. 
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Video kodlayıcı (VENC) ekran göstericisinden gösteri çerçevelerini alır ve istenen 

çıkış formatına dönüştürür. Veri, saat ve eşzamanlandırma gibi çıkış sinyallerini 

gösterim arayüzlerine göndermektedir. VENC üç alt bloktan oluşmaktadır: 

 Analog video kodlayıcı NTSC/PAL televizyon gösterimlerine gönderilen 

sinyalleri yaratır. 

 Sayısal LCD denetleyicisi çeşitli sayısal LCD gösterim formatlarına uygun 

arayüzleri destekler. 

 Zamanlama jeneratörü analog video çıkışı ve sayısal video çıkışları için 

zamanlama sinyalleri oluşturmaktadır. 

3.3.2.  Video Sürücüden YCbCr Verisinin Yakalanması 

Analog sinyali sayısal YUV422 verisine dönüştüren TVP5146 video çözücüsüne 

CCD kamera bağlanmıştır. 8-bit veri yolundan doğru YUV422 verisi DM6437 

işlemcisine gönderilmektedir. TVP5146 video çözücüsünü yapılandırmak için 

TVP5146 ile DM6427 (I
2
C) protokolü ile haberleşmektedir. Sistemin temel blok 

diyagramı Şekil 3.6‟te gösterilmiştir. 

 

Şekil 3.6. YUV422 verisinin yakalanması [19] 

Veriyi yakalamak ve göstermek için VPFE sürücüsü aşağıdaki gibi basamaklar 

yürütülmektedir: 

 CCDC kanalı yaratmak ve parametreleri aktarmak için FVID_Create() 

fonksiyonu çağrılmaktadır. Veri akışı PSP_VPFE_CCDC_YCBCR_8 olarak 

seçilmiştir. Verinin çerçeve genişliği ve uzunluğuysa çalışmamda PAL 

televizyon sistemi kullanıldığından 720 x 576 olarak seçilmiştir. TVP5146 video 
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çözücüsüne ilişkin 3 fonksiyon da VPFE sürücüsündeki CDCC parametrelerine 

aktarılmaktadır. 

 PSP_VPFE_TVP5146_Open() fonksiyonu DM6437 ve TV5146 çözücüsü 

arasında I
2
C arayüzü yetkilendirmek için CCDC kanalı yaratıldığında 

çağrılmaktadır. 

 PSP_VPFE_TVP5146_Close() fonksiyonuysa I
2
C arayüzünün yetkilendirilmesi 

kaldırıldığında çağrılmaktadır. 

 PSP_VPFE_TVP5146_Control() TVP5146‟ nın seçeneklerini yapılandırmak 

gerektiğinde çağrılmaktadır. 

 CCDC kanalı yaratıldıktan sonar FVID_Control() komutuyla TVP5146 video 

çözücüsü yapılandırılmaktadır. Çoğu yapılandırma parametreleri tipik kullanım 

açısından optimum bir şekilde oluşturulduğundan, bu komut TVP5146‟ nın tekrar 

yapılandırılması durumunda kullanılmaktadır. 

 FVID_alloc() fonksiyonunun çağrılmasıyla CCDC modülü için iki çerçeve 

tampon yer ayrılır. Ve tamponlar FVID_queue() fonksiyonuyla sürücüye 

yüklenir. 

 VPBE‟ deki VIDWIN0 kanalı VID_create() fonksiyonu yardımıyla yaratılır ve 

YUV422 formatından yakalanan verilerin gösterilmesi için VIDWIN0‟ I 

yapılandıran parametreler oluşturulur. 

 FVID_alloc() fonksiyonunun çağrılmasıyla VIDWIN0 için iki çerçeve tampon 

için yer ayrılır. Tamponlar sürücüye FVID_queue() fonksiyonu yardımıyla 

yüklenmektedir. 

 VPBE‟ deki VENC kanalı VID_create() fonksiyonu yardımıyla yaratılır ve 

sinyallerin gösterilmesi için VENC modülünü yapılandıran parametreler 

oluşturulur. 

 Belirli zamanlarda giriş video sinyallerini yakalamak ve göstermek için döngü 

oluşturulur. Döngünün içerisinde şu işlemler yürütülmektedir: 

 FVID_exchange() fonksiyonu yardımıyla yeni bir video çerçevesi yakalanır ve 

CCDC modülüne transfer edilir. Fonksiyon CCDC modülü yeni bir çerçeve 

yakaladıktan sonar geri döndürülür. 
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 FVID_exchange() komutu kullanılarak yakalanmış veriyi içeren çerçeve 

tamponunu VIDWIN0‟ a transfer edilip yeni bir çerçeve tampon alınmaktadır. 

 Döngü tamamlandığında bütün kanallar ve çerçeve tamponları serbest 

bırakılmaktadır: 

 VIDWIN0 için iki çerçeve tamponunu serbest bırakmak için FVID_free() iki 

defa çağrılır. VIDWIN0 kanalını serbest bırakmak içinse FVID_delete() çağrılır. 

 CCDC için iki çerçeve tamponunu serbest bırakmak için FVID_free() iki defa 

çağrılmaktadır. CCDC kanalını serbest bırakmak içinse FVID_delete() 

fonksiyonu çağrılır. 

 VENC kanalını serbest bırakmak içinse FVID_delete() çağrılır. 

3.4. Code Composer Studio(CCS) 

Code Composer Studio (CCS) programı, bütün TI DSP çeşitlerinin yazılımsal 

programlama aracıdır. CCS sayesinde kodlar yazılıp derlenir, çalıştırılabilir dosya 

üretilebilir ve programlar debug özelliği sayesinde çalışma zamanında  

izlenebilmektedir [23]. Şekil 3.7‟de CCS blok yapısı gösterilmektedir. 

 

Şekil 3.7. CCS blok yapısı [23] 

CCS, derleyici ,assembler ve bağlayıcı(linker) birimlerini bir arada 

bulundurduğundan ayrı ayrı programlar kurulmasına ihtiyaç duyulmamaktadır. Ve 
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tam versiyonlarında ek olarak DSP simülatörleride bulunmaktadır. Ayrıca TI 

DSP/BIOS gerçek zamanlı işletim sistemi DSP‟lerin içine gömülerek 

çalıştırılabilmektedir. DSP/BIOS kesme kaynaklarını, bilgisayar haberleşmesini, giriş 

çıkışları gerçek zamanlı yürüterek daha önemli işlere yüksek öncelik verilmektedir. 

Programlar, C, C++ ve assemblyde dillerinde yazılabilmektedir. Tez kapsamında 

geliştirilen video stabilizasyon sistemi CCS kullanılarak TMS320DM6437 

platformuna uygulanmıştır. CCS‟nin kullanımı ile temel bilgiler Ek-1‟de verilmiştir. 
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4.  DSP ĠLE GERÇEK ZAMANLI VĠDEO STABĠLĠZASYONU 

Önerilen video stabilizasyon sistemi Texas Instruments‟ın DaVinci DSP 

TMS320DM6437 kitinde uygulanmıştır. Analog kameradan alınan sayısallaştırılmış 

ardışık görüntü çerçevelerinin faz korelasyonu (1.1)'deki gibi hesaplanmaktadır.  

 Faz korelasyonu işlemi için iki çerçevenin ayrık Fourier dönüşümünün hesaplanması 

gerekmektedir. Ayrık Fourier hesabı için Texas Instruments firmasının DSPLib adını 

verdiği kendi sayısal işaret işleme donanımları için geliştirdiği kütüphaneden 

faydalanılmıştır. Sistemimizde iki boyutlu video çerçevelerimiz YCbCr(4:2:2) 

formatta 8 bit piksel derinliğinde tek boyutlu bir dizi şeklinde elde edilmektedir. Bu 

durum iki boyutlu veriye direk erişim sağlanamadığından ek işlem maliyeti 

getirmektedir. Bu durumda faz korelasyonu için gerekli olan 2- boyutlu(2D) FFT'nin 

işlem basamakları ise şu şekildedir: 

 Bütün satırların FFT‟si alınır. 

 Sonuç matrisinin devriği (transpose) alınır. 

 Bütün sütunların FFT‟si alınır. 

 Sonuç matrisinin devriği alınır. 

Aynı şekilde ters FFT işlemini de FFT yerine IFFT kullanılarak gerçekleştirebiliriz. 

DSPLib‟in FFT işlemi için kullandığımız fonksiyonu giriş verisi üzerinde değişikliğe 

neden olduğundan orijinal verinin bozulmaması için bu fonksiyona girdi olarak 

verilecek dizi değerlerinin öncelikle başka bir geçici diziye kopyalanması ve  işlemin 

bu dizi üzerinden gerçekleştirilmesi gerekmektedir. Çalışmalar sonucunda,  geçici 

kopyalama işleminde indis değerleri uygun şekilde ayarlanıp ek bir işlem olarak 

devrik alma işleminin kullanılmamasının  faz korelasyonu sonucuna etki etmediği 

görülmüştür. Bu durumun ayrıca işlemsel yük açısından da kazanç sağladığı 

gözlemlenmiştir
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Şekil 4.1‟de bu işlemlerin nasıl gerçekleştiği matrisler üzerinden gösterilmektedir. 

 

   a)                    b)  

 

   c)          d) 

 

e)          f) 

Şekil 4.1. İki boyutlu faz korelasyonu a) Giriş değerleri b) Giriş matrisinin satırlarının 

FFT matrisi c) Giriş matrisinin sütunlarının FFT matrisi d) Ara işlemler sonrası oluşan sonuç 

matrisinin satırlarının FFT matrisie) Ara işlemler sonrası oluşan sonuç matrisinin 

sütunlarının FFT matrisi f) Faz korelasyon sonucu 
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FFT işlemi için DSPLib kütüphanesinde bulunan daha düşük eleman değerleri 

üzerinden işlem yapabilen düşük boyutlu işlemler için kullanılan FFT fonksiyonunun 

kullanımının ek bir işlem olarak ölçekleme işlemini getirmesine rağmen hesapsal 

yükü azalttığı görülmüştür.  

2D FFT için satır ve sütun işlemlerinde gerekli olan hafıza aktarım işlemlerinde 

CPU‟dan bağımsız bir şekilde verilerin hızlı bir şekilde kaynak adresten hedef adrese 

aktarılmasına olanak sağlayan EDMA (Enhanced Direct Memory Access) 

kullanılması uygun görülsede, EDMA ön ayarlamalarının sürekli çağırılmasının 

sonucu olarak hesapsal yükü arttırdığından, gerçek-zamanlı işlemlerde  yeterli 

başarımı sağlamadığı görülmüştür.  Bu yüzden DSPLib içerisinde bulunan blok 

hafıza aktarım fonksiyonlarının kullanılması uygun bulunmuştur.  

Faz korelasyonunda 2D FFT işleminden sonra kompleks çarpım, karekök, mutlak 

değer hesabı gibi işlemlere ihtiyaç duyulmaktadır.  İlk olarak  C kütüphanesinin 

çarpım, karekök ve mutlak değer alma gibi fonksiyon ve operatörleri kullanılmıştır. 

Bu işlemlerde giriş çerçevelerinin boyutu büyüdükçe hesapsal yük arttığından  

sistemin gerçek-zamanlı çalışması zorlaşmaktadır. Bu sorunun üstesinden gelebilmek 

için “intrinsic” adı verilen ve derleyici tarafından derleme zamanında assembly diline 

çevrilmesi sağlanan fonksiyonlardan yararlanılmıştır. Bu fonksiyonlar SIMD (Single 

Instruction Multiple Data)  yapısını kullanmaktadır. SIMD mimarisinde, aynı komut 

bir çok farklı veri üzerinde paralel olarak yürütülür.  Böylece  C kütüphanesinde 

bulunan aynı işlemi yerine getiren fonksiyon ve operatörler yerine intristic 

fonksiyonların kullanılmasının zamansal açıdan başarımı arttığı görülmüştür. 

Bu çalışmada Kalman filtresinin uygulaması için Texas Instruments‟ ın kullanıcılar 

için sağladığı gerçek-zamanlı uygulamalarda kullanılabilecek olan VLIB 

kütüphanesinin Kalman filtresi fonksiyonu kullanılmıştır. Fonksiyona girdi olarak 

faz korelasyonu sonucu elde edilen hareket vektörleri verilerek, ölçüm gürültüsü 

varyansı ve işlem gürültüsü varyansı için belirlenen en uygun değerlere göre, 

Kalman filtresiyle düzgünleştirilmiş yeni hareket vektörleri elde edilmektedir. Şekil 

4.2‟te örnek bir hareket vektörü dizisi ve ona bağlı olarak oluşan kalman filtresi 

sonucu gösterilmektedir.  
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Şekil 4.2. Kalman filtresi çıkışı 

Geri çatma işleminde ara değerleme yöntemi gerçek-zamanlı bir sistem için ek 

işlemsel yük getirdiğinden, bu çalışmada 720×576 olan video boyutu 660×516 olarak 

ayarlanmıştır.  İki boyutlu video çerçevelerinin YCbCr formatta tek boyutlu bir dizi 

şeklinde elde edilmesinden dolayı iki düzlemde olacak olan geri çatma işlemi 

gösterici değişimi veya basit kopyalama işlemleriyle gerçekleştirilememektedir. Bu 

yüzden EDMA‟nın iki boyutlu kopyalama işleminden faydalanılmıştır. EDMA iki 

boyutlu kopyalama işleminin yanı sıra geri çatma işlemi için gerekli işlemsel yükü de 

azaltmaktadır. Geri çatma işleminde video boyutunu azaltmak için çerçevenin geri 

kalan kısmının belirli bir renk değeriyle doldurularak, böylece görüntü ekranında 

kullanıcının sadece stabilize edilmiş görüntüyü izleyebilmesi sağlanmıştır. 

Geliştirilen sistemin örnek görüntüsü Şekil 4.3‟te verilmektedir. 
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Şekil 4.3. Önerilen video stabilizasyon sistemi 

Yapılan çalışmalar sonucu geliştirme aşamalarında her işlemin hesapsal yük 

açısından sağladığı kazanç, toplam işlem süresi ve sistem saniyede işleyebildiği 

çerçeve sayıları (fps) Tablo 4.1‟de gösterilmiştir.  

Tablo 4.1. İşlem süre tablosu(ms) 

ĠĢlem FFT 
Ara 

iĢlemler 

Toplam 
Stabilizasyon 

Geri 

Çatma 
FPS 

PHC 

  20,8 33,8 77,9 (----) (----) 14 

Intristic İşlemler 20,8 20,1 66,8 (----) (----) 15 

FFT iyileştirmesi 18,9 12,6 53,7 (----) (----) 18 

Düşük boyutlu FFT 14,8 6,7 36,5 (----) (----) 25 

Kalman ile 

Stabilizasyon 
" " " 0 (----) 25 

Geri Çatma " " " 0 22,19 16 

İki Boyutlu EDMA 

kullanılarak geri çatma 
" " " 0 0.99 25 
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SONUÇLAR VE ÖNERĠLER 

Bu çalışmada faz korelasyonu yöntemiyle çerçeveler arası hareket vektörleri 

hesaplanarak, Kalman filtresi kullanılarak hesaplanan hareket vektörlerden 

istenmeyen hareket vektörlerinin bastırılıp sadece istenen hareketlerin korunduğu 

donanımsal bir sistem gerçekleştirilmiştir.  

Faz korelasyonun yerel hareket değişimlerinden etkilenmeyerek,  bütünsel hareket 

kestirimde başarılı olduğu görülmüştür. Kalman süzgeci düşük hesapsal yük değerine 

karşın, yüksek  stabilizasyon performansına sahiptir.  

Bu tez çalışmasında gerçekleştirilen video stabilizasyon sistemi Texas Instruments‟ın 

DaVinci DSP DM6437 kitinde 25 çerçeve/s 660×516 çözünürlüklerde yüksek 

stabilizasyon başarımıyla uygulanmıştır.  

Literatürde video stabilizasyon sistemimize benzer bir çalışma [22]‟de 

önerilmektedir. Bu çalışmada hareket kestirim aşamasında düşük hesapsal yüke sahip 

olmasına rağmen hareket kestirim başarımı düşük olan alt-imge temelli hareket 

kestirimi kullanılırken hareket düzeltim aşamasında ise Kalman filtresi tercih 

edilmiştir. [22]‟de önerilen video stabilizasyon sistemi 28 çerçeve/s  360×240 

çözünürlüklerde DM6437 kitinde çalışmaktadır. Bu tez çalışmasında gerçekleştirilen 

video stabilizasyon sistemi daha güvenilir bir stabilizasyon yöntemi kullanarak 

yaklaşık olarak aynı çerçeve/s çalışma hızına sahip olmasına rağmen daha yüksek 

çözünürlüklerde çalışarak benzeri çalışmalardan ayrılmaktadır. 

Önerilen sistem tüketici elektroniği, kurtarma robotları, el-kameraları v.b. uygulama 

alanlarına sahiptir. 
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Ek-1 

CODE COMPOSER STUDIO KULLANIMI 

CCS IDE programının açılışından sonra CCS‟nin ilk açılış ekranı Şekil Ek-1.1‟de 

gösterilmektedir. 

 

Şekil Ek-1.1. CCS açılış ekranı 

Yeni bir dosya oluĢturulması 

File->Source File tıklanır. Ana pencerede “Untitled1” penceresi açılmaktadır. Şekil 

Ek-1.2‟de yeni pencere oluşturulması gösterilmektedir.
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Şekil Ek-1.2. Yeni pencere olışturulması 

Yeni bir proje oluĢturulması 

Bir önceki adımda oluşturulan dosyaları Project->New seçilerek oluşturulan yeni 

projede kullanabilir. Yeni proje oluşturulması Şekil Ek-1.3‟te gösterilmektedir. Proje 

oluşturulduktan sonra Şekil Ek-1.4‟teki gibi CCS ana menüsünden erişim 

sağlanabilmektedir. 

 

Şekil Ek-1.3. Yeni proje oluşturulması 
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Şekil Ek-1.4. Yeni 

oluşturulan projeye CCS ana 

menüsünden erişim 

OluĢturulan Projeye Dosya Eklenmesi 

Şekil Ek-1.5‟te gösterildiği gibi Select->Add Files to Project seçilerek projeye yeni 

dosyalar eklenmesi gerçekleştirilebilir. 

 

Şekil Ek-1.5. Oluşturulan projeye dosya eklenmesi 

GeliĢtirilen Projenin Derlenmesi 

Geliştirilen proje Project->Build All/Rebuild All seçenekleriyle derlenebilmektedir. 

Örnek bir başarılı proje derleme sonucu Şekil-Ek1.6‟ da gösterilmektedir. 
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Şekil Ek-1.6. Örnek bir başarılı proje derleme sonucu 

Program Yüklenmesi 

Geliştirilen proje başarılı bir şekilde derlendikten sonra CCS,.out uzantılı bir DSP 

içine yükleyebiliceğimiz bir sonuç programı üretir. Bu .out uzantılı Şekil Ek-1.7 ve 

Şekil Ek-1.8‟de gösterildiği gibi dosya File->Load Program seçeneğiyle DSP içine 

yüklenir. 

 

Şekil Ek-1.7. DSP‟ ye yüklenecek program seçimi 
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Şekil Ek-1.8. DSP‟ ye program yüklenmesi 

ÇalıĢma zamanında değiĢkenlerin görüntülenmesi 

Wiev->Watch Window seçeneğiyle istenen değişkenin değeri Şekil Ek-1.9‟daki gibi 

görüntülenebilmektedir. 

 

Şekil Ek-1.9. Değişken değerlerinin görüntülenmesi 
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Yüksek Lisans öğrenimine başladı. 2012 yılında mezun olma durumundadır. 2010 

Eylül ayından itibaren Kocaeli Üniversitesi Mühendislik Fakültesi Elektronik ve 

Haberleşme Bölümü İşaret ve Görüntü İşleme Labaratuarında Araştırmacı olarak 

görev yapmaktadır. 


